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Changelog
Issue Changes Date
1.0 First version. 21/04/2019
1.1 Revision according to “CCI_HRLC_Ph1_Milestone5_RID-ESA.v1.xIsx” 04/05/2020

Detailed Change Record

Issue RID Description of discrepancy Sections Change

1.1 FR-01 Suggested to report the reference year | 2.3  Global | Reference year included in
2019 in the title, even if there are fields | Attributes the title metadata.
related to the time coverage. (Metadata)

1.1 FR-02 The LC class legend reported in the Table = 2.6 Legend @ The legend related to Al#41

2 is the one generated by the climate | for

group and as per Al#41 Climate group to | classification
circulate changed legend to the users to | products
have feedback?

is the LCC legend (as coming
from the Users survey). The
legend has been updated
with latest version and a
clarification on the mapping
between pixels value and
legend codes has been
added (see Sections 3.1.1,
4.1.1,5.1.1).
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1 Introduction

1.1 Executive summary

Following the activities of user requirements updating according to Climate User Community and other users’
consultations, the Consortium worked on defining HRLC products requirements accounting for technical
constraints such as main data sources available, spatial and temporal coverage, software and tools for quality
control. The PUG start from the description of Product Specification and details some of the information that are
together with the products (Climate Research Data Package, CRDP). The CRDP v0 is delivered on the basis of the
Round Robin activity and will be updated on the basis of the finalization of the processing pipelines and
generation of the first version of the products (v1).

The PUG contains the description of the following products that will be part of the Data Package:

e Static High Resolution Land Cover Map for year 2019

e Historical High Resolution Land Cover Map every 5 years since 1990 until 2015

e Historical High Resolution Land Cover Change Detection Map every year since 1990 until 2015
e NDVI/EVI indexes every 4 months since 1990 until 2015

1.2 Purpose and scope

The purpose is to present the product to users having access to the repository of products and to the delivery
system. Practically speaking, the document is normally stored in the same directory as the product repository
root directory to allow the users to understand the content of the repository and the content of the files without
downloading huge amount of data.

The first part of the document presents the summary of the products that will be delivered as specified in the
PSD together with introduction to the general product features that applies to all products: Area of Interest,
Metadata, Format general considerations and Legend (which applies to classification products).

The second part presents a chapter for each of the product with information on Format, Metadata, Projection
and Naming (according to CCI Data Standards).

In the future versions of this document, it will provide more details on the products, some example images
screenshots and a detailed user manual for the Delivery System.

1.3 Applicable documents
Ref. Title, Issue/Rev, Date, ID

[AD1] CCI HR Technical Proposal, v1.1, 16/03/2018

[AD2] CCl Extension (CCI+) Phase 1 — New ECVs — Statement of Work, v1.3, 22/08/2017, ESA-CCI-PRGM-EOPS-
SW-17-0032

[AD3] Data Standards Requirements for CCI Data Producers, v2.1, 02/08/2019, CCI-PRGM-EOPS-TN-13-0009

[AD4] Product Specification Document, v2.0, 03/01/2020, CClI_HRLC_Ph1-D2.0_PSD

[AD5] Product Validation Plan, v2.0, 06/01/2020, CClI_HRLC_Ph1-D2.5_PVP

[AD6] Algorithm Theoretical Basis Document, v2.0, 03/01/2020, CCI_HRLC_Ph1-D2.2_ATBD

[AD7] Product Validation and Algorithm Selection Report, v1.0, 29/10/2019, CCI_HRLC_Ph1-D2.1_PVASR

[AD8] User Requirement Document, v2.1, 22/01/2020, CCI_HRLC_Ph1-D1.1_URD

1.4 Reference documents
N/A
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1.5 Acronyms and abbreviations

API
ccl
CRC
CMUG
CREAF
ECV
ESM
EVI
FTP
GCOS
GDPR
GIS
HR
LAI

LC
LCC
LCCS
LCML
LCZ
LSCE
MR
NDVI
PFT
RS
SFT
Sow
URD
VM
WFS
WMS
WP

Application Programming Interface
Climate Change Initiative

Climate Research Community

Climate Modelling User Group

Centre de Recerca Ecologica i Aplicacions Forestals
Essential Climate Variables

Earth System Models

Enhanced Vegetation Index

File Transfer Protocol

Global Climate Observing System
General Data Protection Regulation
Geodata Information System

High Resolution

Leaf Area Index

Land Cover

Land Cover Change

Land Cover Coverage Classification System
Land Cover Meta Language

Local Climate Zone

Laboratoire des Sciences du Climat et de I'Environnement
Medium Resolution

Normalized Difference Vegetation Index
Plant Functional Type

Remote Sensing

Surface Functional Type

Statement of Work

User Requirements Document

Virtual meeting

Web Feature Service

Web Map Service

Work Package
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2 General Product Description

The user requirements concerning the products generated and the metadata associated are presented in the
following sub-sections. Further details can be found in URD [ADS].

2.1 Products summary

In the Product Specification Document (PSD) the climate user requirements described in the User Requirement
Document (URD) are turned into a set of products specifications. All requirements, needs and suggestions coming
from users’ community consultations and other sources have been carefully analysed and considered. The result
is a trade-off between user requirements and technical requirements is described in detail in [AD4].

The main output described in the PSD consist of:

e A HRLC map at subcontinental level at spatial resolution 10m as reference static input to the climate
models.

e A long-term record of regional HRLC maps at spatial resolution 30m in sub-regions of the static input
for historical analysis every 5 years.

e The change information at 30 m and yearly scale for HRLC map update

e NDVI/EVI seasonal composites

The table below summarizes the product to be delivered after the processor/pipeline integration phase. The
products are described in detail in the sections

Historical Maps - Historical Maps - Historical Maps -
Classification Change Detection NDVI/EVI
Classification Map Classification Map Change Detection Map  Raster Map
10 30 30 30
Sentinel 1, Sentinel 2 Landsat 5-7-8 Landsat 5-7-8 Landsat 5-7-8
Every 4 months from
1990 to 2015
1990-1995, 1996-2000, (selecting the three
2001-2005, 2006-2010, Every year from 1990 to less cloudy images in
2019 2011-2015 2015 the year)
Latitude Longitude Latitude Longitude Latitude Longitude
UTM WGS84 WGS84 WGS84 WGS84
Multiple files (both
NetCDF and GeoTIFF) Multiple files (both Multiple files (both Multiple files (both
organised in tiles NetCDF and GeoTIFF) NetCDF and GeoTIFF) NetCDF and GeoTIFF)

2.2 Key areas location
The geographical coordinates of the three regions are the following:
Amazonia:

®  Static map: (24°S -9°N; 34°W - 62°W)
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® Historical LC and LCC map: (24°S - 12°S; 47°W - 62°W)
Sahel:

®  Static map: (0°N - 18.5°N; 18°W - 43.5°E),
® Historical LCand LCC map: ( 4°N-16°N; 27°E - 43.5°E)

Siberia:

®  Static map: (52°N - 79°N; 65°E - 142°E),
® Historical LC and LCC map: (60°N - 74°N; 65°E - 86°E).

1 [)
f 'y, 1
4 ou Aa ap | : & .
aka . a # a4 'y o H "
P i } . i
At 1
AT s . i ~ '
= a L% 4. L 1
anny, g8 PRS- oty B e
A, ok . T ¥ L ‘ o
i e T A a N 3
T A 4 g
+ a ta e s 4, & i
g | ot a ' 4 s
ag e st B wt
* 4 § , = o
ax " & 3
> a i P
L) ‘.r a & i *A
R ——— 3
" A A LV .
-y A g ————— 1 Al &4
L R
1 ] .
a A : G R ) Pl &
i
_— :A a ! i
A Fluxnet RN 1
1
sites i a H : t 1 N
i I 5 y N
i
Static or b L 5.
history 5 &
. A
T "
history e "
== B
I__lslat\c

a

Figure 1. Final requirements for the location of the 3 study areas and Fluxnet sites.

2.3 Global Attributes (Metadata)

The table below contains the description of the global attributes as defined in Data Standards with an example
reported in the table.

Global Attribute Example

title ESA CCI High Resolution Land Cover 2019 L3P derived
from Sentinel 2 L2A and Sentinel 1 LLGRD

Institution Universita degli Studi di Trento
Fondazione Bruno Kessler

Université Catholique de Louvain
Universita degli Studi di Pavia
Universita degli Studi di Genova
Politecnico di Milano

Université de Versailles Saint Quentin
CREAF

e-GEOS s.p.a.

Planetek Italia
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institution_abbreviation

source CCl High Resolution Land Cover Static Map Processing
Chain 1.0

history 2020-09-01T14:17:10 UTC -- Creation from processor
version v1.0

references http://cci.esa.int/hrlandcover

Conventions

CF-1.6, ACDD-1.3, ISO 8601

product_version

1.0

summary Classification product derived from processing of
Sentinel 1 and Sentinel 2 with resolution of 10 m over
specific Area of Interest with Legend based on a
derivation of LCCS

keywords satellite,observation,ocean

Id ESACCI-HRLC-L4-MERGED-SAHEL-29PPL-00010m-

P1Y-2019-fv01.0.nc

naming authority

Egeos

keywords_vocabulary

NASA Global Change Master Directory (GCMD)
Science

keywords

land cover classification

cdm_data_type

Grid

comment The products are generated as part of ESA CCl HRLC
project

date_created 20200901T120000Z

date_modified 20200901T1200002

creator_name e-GEOS

creator_url

https://www.e-geos.it

creator_email

cci-hrlc@e-geos.it

creator_institution

e-GEOS

project Climate Change Initiative - European Space Agency
geospatial_lat_min 4
geospatial_lat_max 16

degrees_north

geospatial_lon_min

27

geospatial_lon_max

43.5
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geospatial_lon_units

degrees_east

geospatial_vertical_min 0
geospatial_vertical_max 1180
time_coverage_start 20190101T000000Z
time_coverage_end 20191231T000000Z
time_coverage_duration PT1Y
time_coverage_resolution PT1Y

geospatial_bounds

POLYGON ((27. 4., 27. 16., 43.5 16., 43.5 4., 27. 4.))

standard_name_vocabulary

NetCDF Climate and Forecast (CF) Metadata
Convention version 1.6

license ESA CCI Data Policy: free and open access
platform Sentinel 2, Sentinel 1

sensor sensor

spatial_resolution 10m

netcdf_version_id

4.3.0 of Jul 8 2013 12:17:12 $

acknowledgement

Please acknowledge the use of these data with the
following statement: these data were obtained from
the ESA CCI High Resolution Land Cover project

format_version

processing_level

Data Standards Requirements for CCI Data Producers,
v2.1, 2 August 2019

processing_software

CCl High Resolution Land Cover Static Map Processing
Chain 1.0 deployed on e-GEOS Processing System

processing_level L3P
key_variables class
geospatial_lat_units meters
geospatial_lon_units meters
geospatial_lon_resolution 10
geospatial_lat_resolution 10

Table 1: Attribute metadata and example content for HRLC products

2.4 Format considerations

Regarding the format of the products, it has been natural to consider both GeoTIFF and NetCDF as encoding of

the final output. There are important consideration on this regarding the two encoding as:

NetCDF:

e s a portable format meant to include metadata internally and to be very generic about scientific data

e Include the coordinates as variables for various purposes (e.g. it allows non rectangular grid)
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e Itis meant to store multi-dimensional data
e Has the concept of subdataset which is extremely wide

GeoTIFF:

e s portable but has not a strict way of storing metadata and there is not a common convention. Anyway,
metadata can be added.

e Coordinates are derived by the context (top left pixel position, resolution in x and y)

e Has the concept band which is less general that a subdataset as it inherits from the file encoding (e.g. it
does not support different types)

For this reason, as a general behaviour, NetCDF tend to be bigger in dimension (it must store all coordinate values
in float) and less compressable. On the other side, the GeoTIFF cannot store different datatypes (e.g. int and float
together) so it is impossible to store in the same file both a classification (e.g. integer 8 bit) and a posterior
probability (e.g. float 32 bit) or at least a transformation has to be performed like converting the probability in
an integer value from 0 to 100 discarding some of the precision.

In general, the choices made in the “format” paragraphs for each product has the objectives to ease the use of
the product for different audiences like climate modellers (e.g. NetCDF) or geoinformation experts.
For data types, please consider the following references:

e “Band types of Byte, Ulntl6, Int16, UInt32, Int32, Float32, Float64, Cintl6, CInt32, CFloat32 and

CFloat64 are supported for reading and writing. Paletted images will return palette information
associated with the band” from https://gdal.org/drivers/raster/gtiff.html

e Data Type page from NetCDF official documentation:
https://www.unidata.ucar.edu/software/netcdf/documentation/NUG/data type.html

In the case of GeoTIFF, palette information will be reported whenever possible with information about legend
(see paragraph 2.6).

In case of multiple file delivery, for the need of a unique access to a mosaic-like file, a VRT file (GDAL VRT Format,
https://gdal.org/drivers/raster/vrt.ntml) will be delivered containing the merge of all the tile for a global view of

the area. The use of large files is discouraged due to the poor performance and the need to move large amount
of data on the network.

2.5 Archive Directory

The common directory structure for the product repository is based on suggestions and existing conventions
used by CCl teams (as requested by the Data Standard document [AD3]) and is arranged as follows:

[<archive_root>/<type>/<version>/<time>/

where each <...> may itself be complex, e.g.

e <time> may be <year>/<month> or <year>/<day-in-year> or <year>/<month>/<day>

e <archive-root> is /esacci/<cci_project>/

e <cci_project> is e.g. <hrlc> or <aerosol>

o <type> will be different for each ECV, but needs to be defined, and consistent within an ECV
e <version> uniquely identifies the version

2.6 Legend for classification products
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Here follows the FAO LCCS description of land cover classes selected for the CCI HRLC product. This is used both
for classification of the static map and for historical map.

CODE

10

20

30

40

50

60

70

80

90

100

110

120

130

140
150
160

1°* LEVEL

Tree cover evergreen
broadleaf

Tree cover evergreen
needleleaf

Tree cover deciduous
broadleaf

Tree cover deciduous
needleleaf

Shrub cover evergreen

Shrub cover deciduous
Grasslands

Croplands

Woody vegetation
aquatic or regularly
flooded

Grassland vegetation
aquatic or regularly
flooded

Lichens and Mosses

Bare areas

Built-up

Open Water seasonal
Open Water permanent
Permanent snow and/or
ice

CODE 2" LEVEL CODE 3™
LEVEL

51 Broadleaf

52 Needleleaf

61 Broadleaf

62 Needleleaf

71 Natural

72 Managed

81 Winter 811 Rainfed

82

83

121

122

131
132

161
162

812 Irrigated

Summer 821 Rainfed
822 Irrigated

Multicropping 831 Rainfed
832 Irrigated

Unconsolidated 1211 Sands
1212 Bare
soils

Consolidated

Buildings

Artificial Roads

Snow
Ice

Table 2: Legend for the CCI HRLC

CODE 4™ LEVEL

8121
8122

8221
8222

8321
8322

Sparkling
Flooding

Sparkling
Flooding

Sparkling
Flooding
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3 Static High Resolution Land Cover Map Product

3.1 Product Description

The static map at spatial resolution of 10m is one of the main products of the project. Such map will represent
the LC of the three sub-continental areas that have been identified in Section 2.1. The static map will refer to the
year 2019.

The main sources of information will be Sentinel-2 and Sentinel-1 for the case of optical and radar data,
respectively. This focus is explained by the desired spatial resolution of 10m of the product.

The static map will also be associated with a pixelwise measure of uncertainty. Spatial and temporal resolution

The Static Map will be released for year 2019. The production of such product includes analysis and processing
of a large quantity of data from Sentinel-1 and Sentinel-2 missions for the full year 2019. We recall that temporal
resolution of Sentinel optical data can reach 5 days and even less for overlapping orbits. This revisit time is
lowered to up to three days in case of SAR data (less at high latitudes). The processing chain is organised in two
parallel stream of processing (Multispectral and SAR) that are combined after the pre-processing step to perform
an alignment (coregistration between Multispectral and SAR image) and at the end of separate classification
steps where the data fusion is applied to generate the final product. Additional information on the processing
chain are given in [AD7] for what concerns the final selection of the algorithm and in [AD6] for what concern the
algorithms behind the chain.

The legend of the final classification product is defined in 2.6 according to the analysis made by the Scientific
Team together with Climate Modellers.

3.1.1 Format, metadata and projection

Product specifications will be compliant with last update of CCI Data Standards Requirements [AD3]. In particular,
this will ensure complete interoperability of HRLC products with other products delivered in the framework of
CCl. In particular the metadata will be stored in the NetCDF/GeoTIFF as specified in 2.3 and the format as
specified in 2.4. Here we present the table with the list of different information in the dataset (the final data type
is specified both for NetCDF and for GeoTIFF versions):

Layer Description NetCDF GeoTIFF Range
DataType DataType

class Class identified by a number from 1 | NC_BYTE Byte 0-43
to 43 and 0 as no data. Classes are
identified with the legend
described in table 2. Association is
done in the metadata.

probability Probability from 0 to 100 NC_BYTE Byte 0-100

clear_sky The number of observations with | NC_BYTE Byte 0-255
clear sky land coverage, for each
pixel

Cloudy The number of observations of | NC_BYTE Byte 0-255
cloudy coverage, for each pixel
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Shadow The number of observations of | NC_BYTE Byte 0-255
cloud shadow coverage, for each
pixel
Scenes The number of images per pixel NC_BYTE Byte 0-255

Table 3: descriptions of the information content of the product in terms of pixel content (layer, data type, range of
values)

The pixel value from 0 — 43 is mapped to the legend values described in paragraph 2.6 and the mapping is
reported in metadata (e.g. as attribute in the NetCDF or GeoTIFF) so that any Land Cover class code is mapped
uniquely to a pixel value.

The reference projection of the product will be based on the original projection coming from Sentinel 2 data in
order to allow the overlay with original Sentinel 2 images without warping. The final delivery will be thus done
in tiles (as specified in the naming) following the Sentinel 2 MGRS tiling scheme.

Additional delivery projection and data organisation (WGS84 Lat Lon, Single Mosaic File, Different Tiling) will be
discussed at the time of the first delivery taking into account of the size of products and of requirements coming
from Climate Modellers.

3.1.2 Naming
The files for each product type are named according to the CCl Data Standards defined

ESACCI-<CCI  Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional Segregator>]
<IndicativeDate>[<Indicative Time>]-fv<File version>.nc

Where:
<CClI Project>
ESACCI- HRLC

<Processing Level>

L4

<Data Type>
Map

<Product String>
MERGED

<Additional Segregator Tile>
Tile code for the area of interest: SAHEL, SIBERIA, AMAZONIA

<Additional Segregator Tile>
Tile code following Sentinel 2 tiling system based on MGRS: 5 total chars

<Additional Segregator Resolution>
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Resolution of the product using 5 digits and unit of measure (m for meters and d for degree)

<Start Date> and <End Date>

The identifying date for this data set is YYYY, where YYYY is the four digit year. As prefix, the indication of the
period is given as specified in Data Standard document with ISO notation

<File Version>
File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and another 1 or more
digits).

Example:

e ESACCI-HRLC-L4-MERGED-SAHEL-29PPL-00010m-P1Y-2019-fv01.0.nc
e  ESACCI-HRLC-L4-MERGED-SAHEL-29PPL-00010m-P1Y-2019-fv01.0.tif

3.1.3 Delivery

The delivery will be managed in two ways:

e FTP or HTTP service with data organised in a folder structure as specified in 2.5
e Delivery system with possibility to use WMS/WCS services and a user interface

Here is an example of the Web Interfaces showing a classification product:

X
Wi ol HALE
[ |
= & Default
=@
B
=3

S @ Land Cover epoch

Mag data € OperiSieetiap, SATM | Map shyle € Openfopobap 00-Br-54) L Wom ) Scaa 1 0 - 0

Figure 2: Example visualization of classification product through a Web-GIS interface accessing a WMS service

4 Historical High Resolution Land Cover Map Product

4.1 Product Description

The historical map at spatial resolution of 30m is one of the main products of the project. Such map will represent
the LC of the three sub-continental areas that have been identified in Section 2.1. The static map will be produced
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on the basis of Landsat acquisitions of 5 years (to allow to have enough scenes to be used) and in particular for
the following 5-years periods: 1990-1995, 1996-2000, 2001-2005, 2006-2010, 2011-2015

The main sources of information will be Landsat 5, Landsat 7 and Landsat 8 and also ERS-1, ERS-2, ENVISAT-ASAR
will also be considered. The land cover map will also be associated with a pixelwise measure of uncertainty.

The Land Cover Map Change product is part of the Historical high resolution land cover chain and is based on the
following steps: i) production of a LC change map for each year; and ii) production of the 5-year LC maps after
the analysis of the related yearly LC change maps. Additional information on the processing chain are given in
[AD7] for what concerns the final selection of the algorithm and in [AD6] for what concern the algorithms behind
the chain.

The Land Cover Change Detection product is described in chapter 5.

Spatial and temporal resolution of the historical HRLC map products of the CCl HRLC are summarized in Error!
Reference source not found..

4.1.1 Format, metadata and projection

Product specifications will be compliant with last update of CCI Data Standards Requirements [AD3]. In particular,
this will ensure complete interoperability of HRLC products with other products delivered in the framework of
CCl. In particular the metadata will be stored in the NetCDF/GeoTIFF as specified in 2.3 and the format as
specified in 2.4. Here we present the table with the list of different information in the dataset (the final data type
is specified both for NetCDF and for GeoTIFF versions):

Layer Description NetCDF GeoTIFF Range
DataType DataType

class Class identified by a number from 1 | NC_BYTE Byte 0-43
to 43 and 0 as no data. Classes are
identified with the legend
described in table 2. Association is
done in the metadata.

probability Probability from 0 to 100 NC_BYTE Byte 0-100

clear_sky The number of observations with | NC_BYTE Byte 0-255
clear sky land coverage, for each
pixel

cloudy The number of observations of | NC_BYTE Byte 0-255
cloudy coverage, for each pixel

shadow The number of observations of | NC_BYTE Byte 0-255
cloud shadow coverage, for each
pixel

scenes The number of images per pixel NC_BYTE Byte 0-255

Table 4: descriptions of the information content of the product in terms of pixel content (layer, data type, range of
values)
The pixel value from 0 — 43 is mapped to the legend values described in paragraph 2.6 and the mapping is
reported in metadata (e.g. as attribute in the NetCDF or GeoTIFF) so that any Land Cover class code is mapped
uniquely to a pixel value.
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The reference projection of the product will be based on the original projection coming from Sentinel 2 data in
order to allow the overlay with original Landsat images without warping. The final delivery will be thus done in
tiles (as specified in the naming) following the Landsat Path/Row tiling scheme.

Additional delivery projection and data organisation (WGS84 Lat Lon, Single Mosaic File, Different Tiling) will be
discussed at the time of the first delivery taking into account of the size of products and of requirements coming
from Climate Modellers.

4.1.2 Naming

The files for each product type are named according to the CCI Data Standards defined

ESACCI-<CCI  Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional Segregator>]
<IndicativeDate>[<Indicative Time>]-fv<File version>.nc

Where:

<CCI Project>
ESACCI- HRLC
<Processing Level>

L4

<Data Type>
Map

<Product String>

MERGED

<Additional Segregator Tile>
Tile code for the area of interest: SAHEL, SIBERIA, AMAZONIA

<Additional Segregator Tile>
Tile code following Landsat Path/Row using 3 chars for Path and 3 chars for Row: PPPRRR

<Additional Segregator Resolution>

Resolution of the product using 5 digits and unit of measure (m for meters and d for degree)

<Additional Segregator Tile>
Specific to Change Maps: LandCover

<Start Date> and <End Date>

The identifying date for this data set is YYYY, where YYYY is the four digit year of the last year

<File Version>
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File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and another 1 or more
digits).

Example:

e  ESACCI-HRLC-L4-MERGED-SAHEL-171051-00030m-LandCover-P5Y-2015-fv01.0.nc
e ESACCI-HRLC-L4-MERGED-SAHEL-171051-00030m-LandCover-P5Y-2015-fv01.0.tif

4.1.3 Delivery

The delivery will be managed in two ways:

e  FTP or HTTP service with data organised in a folder structure as specified in 2.5
e Delivery system with possibility to use WMS/WCS services and a user interface

5 Historical High Resolution Land Cover Change Detection

5.1 Product Description

The historical map change detection at spatial resolution of 30m is one of the main products of the project. Such
map will represent the change in the land cover (the value in the pixel is the class to which the pixel has changed)
of the three sub-continental areas that have been identified in Section 2.1. The change map will be produced on
the basis of Landsat acquisitions of 1 year from 1990-2019.

The main sources of information will be Landsat 5, Landsat 7 and Landsat 8.

The Land Cover Map Change product is part of the Historical high resolution land cover chain and is based on the
following steps: i) production of a LC change map for each year; and ii) production of the 5-year LC maps after
the analysis of the related yearly LC change maps. Additional information on the processing chain are given in
[AD7] for what concerns the final selection of the algorithm and in [AD6] for what concern the algorithms behind
the chain.

The Land Cover Map product is described in chapter 5.

Spatial and temporal resolution of the historical HRLC map products of the CCl HRLC are summarized in Error!
Reference source not found..

5.1.1 Format, metadata and projection

Product specifications will be compliant with last update of CCI Data Standards Requirements [AD3]. In particular,
this will ensure complete interoperability of HRLC products with other products delivered in the framework of
CCl. In particular the metadata will be stored in the NetCDF/GeoTIFF as specified in 2.3 and the format as
specified in 2.4. Here we present the table with the list of different information in the dataset (the final data type
is specified both for NetCDF and for GeoTIFF versions):

Layer Description NetCDF GeoTIFF Range
DataType DataType

class Class identified by a number from 1 | NC_BYTE Byte 0-16
to 16 and 0 as no data. Classes are
identified with the legend
described in Table 2. The value is
the class to which the pixel has
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changed (considering only level 1 of
the LC legend). Association is done
in the metadata.

probability Probability from 0 to 100 NC_BYTE Byte 0-100
Table 5: descriptions of the information content of the product in terms of pixel content (layer, data type, range of
values)
values)

The pixel value from 0 — 16 is mapped to the legend values described in paragraph 2.6 (only Level 1 in the case
of change detection) and the mapping is reported in metadata (e.g. as attribute in the NetCDF or GeoTIFF) so
that any Land Cover class code is mapped uniquely to a pixel value.

The reference projection of the product will be based on the original projection coming from Sentinel 2 data in
order to allow the overlay with original Landsat images without warping. The final delivery will be thus done in
tiles (as specified in the naming) following the Landsat Path/Row tiling scheme.

This additional delivery projection and data organisation (WGS84 Lat Lon, Single Mosaic File, Different Tiling) will
be discussed at the time of the first delivery taking into account of the size of products and of requirements
coming from Climate Modellers.

5.1.2 Naming
The files for each product type are named according to the CCI Data Standards defined

ESACCI-<CCI  Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional Segregator>]
<IndicativeDate>[<Indicative Time>]-fv<File version>.nc

Where:

<CCI Project>
ESACCI- HRLC
<Processing Level>

L4

<Data Type>
Map

<Product String>

MERGED

<Additional Segregator Tile>
Tile code for the area of interest: SAHEL, SIBERIA, AMAZONIA

<Additional Segregator Tile>
Tile code following Landsat Path/Row using 3 chars for Path and 3 chars for Row: PPPRRR

<Additional Segregator Resolution>
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<Additional Segregator Tile>
Specific to Change Maps: ChangeDetection

<Start Date> and <End Date>
The identifying date for this data set is YYYY, where YYYY is the four digit year

<File Version>

File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and another 1 or more
digits).

Example:

e ESACCI-HRLC-L4-MERGED-SAHEL-171051-00030m-ChangeDetection-P1Y-2015-fv01.0.nc
e ESACCI-HRLC-L4-MERGED-SAHEL-171051-00030m-ChangeDetection-P1Y-2015-fv01.0.tif

5.1.3  Delivery
The delivery will be managed in two ways:

e  FTP or HTTP service with data organised in a folder structure as specified in 2.5
e Delivery system with possibility to use WMS/WCS services and a user interface

Here is an example of the Web Interfaces showing a change detection product with the possibility to show
“transitions” among different land cover or only those of interest:

W oI HRLE

Figure 3: Example visualization of change detection product through a Web-GIS interface accessing a WMS service
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6 Historical High Resolution Land Cover NDVI/EVI

6.1 Product Description

The NDVI products are derived from internal steps of the historical map land cover processing chain. During the
processing, an additional step will be added to derive 3 files per analyzed year (1990-2019) that corresponds to,
alternatively:

e Oneimage per season (not including winter one for obvious reasons)
e Less cloudy images per year (which are not necessarily equally distributed in time).

The product is made of one single band and there is no confidence information, since it is a simple mathematical
product that does not depend on any further process from our side.

6.1.1 Format, metadata and projection

Product specifications will be compliant with last update of CCI Data Standards Requirements [AD3]. In particular,
this will ensure complete interoperability of HRLC products with other products delivered in the framework of
CCl. In particular the metadata will be stored in the NetCDF/GeoTIFF as specified in 2.3 and the format as
specified in 2.4. Here we present the table with the list of different information in the dataset (the final data type
is specified both for NetCDF and for GeoTIFF versions):

Layer Description NetCDF GeoTIFF Range
DataType DataType
index NDVI/EVI value for each pixel with | NC_FLOAT Float32 continuous values from -
values ranging from [-1,1], 1to-1

representing areas with no
vegetation (NDVI<0) and areas with
vegetation (NDVI>0).

Table 6: descriptions of the information content of the product in terms of pixel content (layer, data type, range of
values)

The reference projection of the product will be based on the original projection coming from Sentinel 2 data in
order to allow the overlay with original Landsat images without warping. The final delivery will be thus done in
tiles (as specified in the naming) following the Landsat Path/Row tiling scheme.

This additional delivery projection and data organisation (WGS84 Lat Lon, Single Mosaic File, Different Tiling) will
be discussed at the time of the first delivery taking into account of the size of products and of requirements
coming from Climate Modellers.

6.1.2 Naming
The files for each product type are named according to the CCI Data Standards defined

ESACCI-<CCI  Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional Segregator>]
<IndicativeDate>[<Indicative Time>]-fv<File version>.nc

Where:

<CCI Project>
ESACCI- HRLC
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<Processing Level>

L3

<Data Type>
NDVI or EVI

<Product String>

MERGED

<Additional Segregator Tile>
Tile code for the area of interest: SAHEL, SIBERIA, AMAZONIA

<Additional Segregator Tile>
Tile code following Landsat Path/Row using 3 chars for Path and 3 chars for Row: PPPRRR

<Additional Segregator Resolution>

Resolution of the product using 5 digits and unit of measure (m for meters and d for degree)

<Start Date> and <End Date>

The identifying date for this data set is MM-YYYY, where MM is the month YYYY is the four digit for the year
of the last acquisition used to calculate the NDVI composite

<File Version>

File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and another 1 or more
digits).

Example:

e  ESACCI-HRLC-L3-NDVI-SAHEL-171051-00030m-P4M-032015-fv01.0.nc
e  ESACCI-HRLC-L3-NDVI-SAHEL-171051-00030m-P4M-032015-fv01.0.tif

6.1.3 Delivery

The delivery will be managed in two ways:

e FTPor HTTP service with data organised in a folder structure as specified in 2.5
e Delivery system with possibility to use WMS/WCS services and a user interface

7 Quality documentation

7.1 Quality Flags

The quality of both the static and historical HR LC maps generated in this project is first documented using a set
of quality flags and values, determined on a per-pixel basis. These are:

1. The status of the pixel, being produced during the pre-processing, through the pixel identification step.
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Six statuses are proposed: “Cloud”, “Shadow”, “Clear land”, “Invalid” and “Filled”.

2. If the pixel has a status different from “Invalid” and “Filled, an indicator describing the overall quality of
the reflectance value (derived from the pre-processing)

3. The number of valid and cloud-free observations used for the classification

4. If the pixel has a status different from “Invalid” and “Filled”, an indicator describing the uncertainty
associated with the land cover class.

5. Forthe HR historical maps, an indicator describing if the pixel has changed with regards to the previous
period.

These information on the pre-processing are then made available in the final product as specified in 3.1.1, in
4.1.1 and in 5.1.1 with availability of posteriors probability for all the L4 products and the addition of the specific
information on “Cloud”, “Shadow” and “Clear Land” of the scenes concurring to the generation of the map (only
for Land Cover maps, not available for Change Detection map).

7.2 Independent validation

A statistical validation framework was established in the context of the GlobCover and CCl Moderate Resolution
(MR) LC projects. This statistical validation framework is organized in four steps as described in Figure 4. These
steps are adjusted to the CCl+ HRLC mapping activities: RR, static maps and change detection.

Processing steps

Collection of HR

mosaics
Independent ) _
statistical ‘ Sampling design
validation
Independent

interpretation

Reporting

Figure 4. Different components of the independent statistical validation component.

LC product accuracy is assessed by comparison with independent data sources such as, ground based in-situ
measurements or higher resolution satellite data. The collection of higher resolution satellite as “ground truth”
is considered as the best option to support the validation of remote sensing products in general and of the HR
LC maps in particular.

Reference data samples are collected on specific areas designed to be statistically valid for accuracy assessment
of the HR LC products, to address the issues of rare classes with a strong impact on the climate system (urban
areas, wetlands, etc.) and to bias a specific sampling for the LC change validation.

The reference data sources are then intended to be interpreted over each validation samples through an
international network of experts in a standardized manner.

Then, the classification is compared to the reference data, and the extent to which these two classifications agree
is defined as map accuracy. The full methodology and the accuracy figures are documented in the Product
Validation Plan [AD5].
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8 User Tool

All the High Resolution Land Cover products will be available through the CCI Climate Open Data portal and
accessible with different methods like:

o FTP

e WMS/WCS

The link to the Delivery System will be made available to the Users as soon as the products are available. The
User Manual will be also added to this section.

The Delivery System is meant to be interfaced by the CClI Toolbox in order to provide easy functionalities for
retrieving.

Appropriate color mapping will be provided in different formats such as SLD (Styled Layer Descriptor) usable in
QGIS and in the CCl Toolbox format to be included directly as information retrieved from the CCl Open Data
Portal.
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